Part — I (Questions : 1 to 40)
aqrr— 1 (79 : 1€ 40)

Directions (Questions 1-3): Choose the word which best expresses the meaning of the
underlined word in the sentence.

1.  The host looked quite jaded by the time the party was over.
(1) miserable (2) exhausted
(3) inspinng (4) cheerful

2. She has an insatiable love for music.
(1) undesirable (2) unchanging
(3) irreconcilable (4) unsatisfiable

3. The art movie | watched this evening has put me in a pensive mood.
(1) cheerful (2) confused
(3) reflective (4) depressed

Directions (Questions 4-6): Choose the word which is closest to the opposite in meaning of the
underlined word in the sentence.

4. He appeared elated on hearing the news.
(1) depressed (2) exasperated
(3) desperate (4) anxious

5. She bought a gaudy shawl as a wedding gift for her sister.
(1) pretty (2) sober
(3) heavy (4) ornate

6. She detests government jobs.
(1) approves of (2) is fond of
(3) adores (4) s interested in

Directions (Questions 7-10): Choose the option which best expresses the meaning of the
underlined idiom/phrase in the sentence.

7. Crossing the river was a herculean task for me.
(1) ecasy work (2) impossible task
(3) anew task (4) work needing great effort

8. He looks down upon his poor cousins.
(1) despises (2) praises openly
(3) neglects (4) caresalot
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9. John is hand in glove with my cousin. i
(1) noton good terms .

(2) not friendly
(3) on good terms
(4) on very intimate terms
10.  He works hard but while solving a pmhlem-ﬁa 15 often at sea.
(1) under confident (2) perplexed
(3) over conlident (4) happy

"

Directions (Questions 11-14): 4 word has been written in Sour different ways out of which only
one is correctly spelt. Choose the correctly spelt word,

11. (1) Accomodation
(2)  Acommodation
(3) Accommodation
(4)  Accommodacian

12. (1) Haress (2) Harrass
(3) Herrass (4) Harass
13. (1) Apreciate (2) Appreciate

(3) Appresiate (4)  Appereciate
14. (1) Jewellery (2) Jewelery
(3) Jewellry (4) Jewalery

Directions (Questions 15-17): The first part of a sentence is provided to you and the remaining
sentence has been broken into four parts. Choose the most logical order of parts from among
the given four choices to construct a correct sentence,

15.  As per latest reports
P.  were still trapped inside
Q.  bogies of the express
R.  the wrecked
S.  some of the passengers
(1) PSQR (2) RSQP
(3) PRQS (4) SPRQ ¥
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16. Dermatologists tell us
P.  that the skin
Q. is a finely laminated coating

R. whose layered nature

S.  has inspired comparisons with onions

(1) RSQP
(3) SPRQ

17. Thousands of students
P. onan all India basis
Q. from all over India
R.  which are held
S.  appear in the examinations
(1) RPQS
(3) QSRP

Directions (Questions 18-20) : In each question, choose the one word which can be substituted

for the given sentence/words.
18. One who is unable to pay one’s debt.
(1) Loanee

(3) Borrower
19. One who knows everything.
(1) Omnipotent

(3) Omniscient

20. Connoisseur of choice food.

(1) Greedy
(3) Gourmand
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(4)

PQRS
QPRS

PRQS
SQPR

Bankrupt

Payee

Intelligent

Genius

Glutton

Gourmet



et (uvs 21 7 22 & fom) Frefefiea famedl & € o a6 9 v Bifen -

21. (1) w=AmHE (2) wEAEE
(3) few=amm (4) ®IEE
22. (1) 9FIEA (2) wEr
(3) wrEHE (4) OrgEr

ﬁ&ﬂ(wzaﬁzsﬁm}ﬁmﬁﬁawﬁ#m@mﬁﬁm:
23, S @ A ST ES

(1) 59 (2) S

(3) Efted= (4) oA
24, S fvET H A WA B

(1) =fay ; (2) iR

(3) TEEeHA (4) =HEEA
25. S ¥ H/S WA B

(1) ¥4 (2) =T

(3) wEEW (4) wdd

ey (w26 ® 28 & fom) 99 R v vl # fofe= fosedl ¥ 9 & v gEfgarE
(gurreds) et €, 39 Bifew . .

26. TEd
(1) = (2) A=
(3) H=U (4) faft
27. FHA
(1) T (2) =S
(3) == (4) fry=
28. 9T
(1) el (2) wu
3 &= (4) =R



fader (wv= 29 & 30 & Taw) R W y= w1 W& faam (fawdtaed=) 9T
29. TfA

(1) st 2) W
(3) &= (4) fe=w
30. 30
(1) 9 (2) FEAta
(3) i (4) STEFE

frdor (wv 31 & 32 & foo) Frefofes o @ fo5g oge & i v Tom fom & & 2
31, A S s

(1) dg, 9, dfaar (2) @M, %F, EF

(3) e, ferarg, wam (4) =@, =ifE, S
32. o gfeen v

(1) wEgy, gaEm, @

(2) 32,4, %

(3) WEES, A, WA
(4) ==, difemn, T

fader (wv 33 & 36 & fom) Frafafes =i & sEvasagar afy sge afy-fasds =

33. =9 + WM
(1) <= (2) =afd
(3) = (4) <wenfd

34, g9 + 3y
(1) =Y (2) =AY

(3) Hsify (4) Ty
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35.

36.

qHd
(1) =g +va (2) 9Y + Ia4d
(3) =Y + IHa (4) =Y + Iwa
ST
(1) =&t + zwmA (2) =T + A
(3) F@ + FTH (4) = + A

frter (w37 & fom) w=-=m =t gfie O Fefafay fawed o @ SH-or s 2

e 2

38.

(1) - (2) H-gEY
(3) wEA-wE (4) wrar-Taar

fr=fafen fawe @ 9 =0 fagey &1 vgam Fifow fad F9a faewm o= = |
(1) =, sis, fewe

(2) ¥®, 98, 3=

(3) HWE, S, dE

(4) 3TN, FEA, A

frder (wvw 39 7 40 & faw) = fau o e @ W e wiew .

39.

40.

TR R FEE
(1) v @
(2) A @WET
(3) & BT B IE
(4) it =Tl e

st T A

(1y T ST

(2) O HE

(3) ita T

(4) TS Y WA



41.

42.

43,

44.

45.

46.

47.

Part — IT (Questions : 41 to 200)

MetLife India Insurance Company Ltd has partnered with , to launch life insurance
business in India.

(1) Punjab National Bank (2} Syndicate Bank

(3) Bank of Baroda (4) Indian Overseas Bank

Who among the following is the Secretary-General of the United Nations Organization 7
(1) Ban Ki-moon (2) Jacques Rogge
(3) Takehiko Nakao (4) None of these

What is the name of the 101 years old person, nicknamed ‘The Turbaned Tormado’, who
quit long distance racing in 2013 7

(1) Khazan Singh (2) Fauja Singh
(3) Makhan Singh (4) Milkha Singh

‘Red Ribbon Express’, an Indian Railways train, runs throughout the country to make
people aware about

(1) Malaria (2) Tuberculosis (TB)
(3) HIV/AIDS (4) Dengue

Sanjiv Mehta has been selected as MD & CEOQ of which of the following companiés with
effect from 01 Oct 2013 7

(1) Cadbury India (2) Nestle India

(3) Hindustan Unilever (4) Britannia

Which cyclone struck the coastal areas of Bangladesh and Myanmar recently 7
(1) Nisha (2) Laila
(3) Mahasen (4) Nilam °

The recently opened 11 km long tunnel linking the towns of Banihal and Qazigund in
J&K runs through the mountain.

(1) Araval (2) Pir Panjal
(3) Hindukush (4) Karakoram
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48.

49,

S0.

S1.

. 8

53.

The writer from Afghanistan who won the SAARC Literature Award in 2013 is
(1) Farheen Chaudhary

(2) Abdul Khaliq Rashid

(3) Mohammad Nurul Huda

(4) None of these

Which of the following hill forts of Rajasthan have been added to the UN World Heritage
Listin 2013 ?

A. Amber, B. Chittorgarh, C. Gagron, D. Jaisalmer
(1) A&B (2) AB&D
3) B,C&D (4) All of these

During a meeting of the UN Climate Conference held in Doha in 2013, the 1997 Kyoto
Protocol, which was to expire in 2012, was extended until

(1) 2015 (2) 2025
(3) 2035 (4) 2020

The Indian Parliament has enacted a legislation making free and compulsory education a
right of every child in the age group 6-14 years. This has come into force since

(1)  April, 2010, (2)  April, 2012.
(3)  April, 2008. (4)  April, 2006.

As per the provisional population totals of Census 2011, which of the following States has
the maximum population density ?

(1) West Bengal (2) Uttar Pradesh
(3) Haryana (4) Bihar

According to the provisional population totals of Census 2011, which of the following
States/UT's has the second highest literacy rate in India ?

(1) Kerala (2) Lakshadweep

(3) Mizoram (4) Tripura
11



54.

a5,

7.

58.

Who received the prestigious Jnanpith Awar_dr for the year 2012 7
(1) Ravuri Bharadwaja

(2) Pratibha Ray

{(3) Amar Kant

(4) Chandrasekhar Kambara

Which one of the following games has been reinstated for the 2020 Olympic Games ?

{1) Squash (2) Baseball
(3) Softball (4)  Wrestling
The Government of India has declared year 2013 to be observed as * Year’.

(1) Water Conservation
(2) Energy Conservation
(3) Wild-life Conservation

(4) Forest Conservation

Who is the Scientific Adviser to the Defence Mimister of India and is also the Director
General of Defence Research and Development Organization (DRDO) ?

(1) Avinash Chander (2) V¥ K Saraswat

(3) S Ramadorai (4) None of these

IDR, an instrument for foreign companies to raise funds from the Indian securities market,

stands for

(1) Indian Dismvestment Receipt.
(2} Indian Domestic Receipt.

(3) Indian Depository Receipt.

(4) Industrial Deposit Receipt.
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59.

60.

61.

62.

64.

President of the USA, Barack Obama represents which of the following political parties ?
(1) Republican Party (2) Libertarian Party

(3) Democratic Party (4) Constitution Party

Who among the following Indian Badminton players has won the Thailand Open Grand
Prix Gold in 2013 ?

(1) PV Sindhu (2) P Kashyap
(3) K Srikanth (4) Saina Nehwal

Who has become the first Indian amputee to conquer Mt. Everest ?
(1)  Anshu Jamsenpa

(2)  Arunima Sinha

(3) Tarun Saikia

(4) Wansuk Myrthong

‘An Uncertain Glory: India and its Contradiction’, is a book co-authored by and
Jean Dreze.

(1) V S Naipaul (2) Chetan Bhagat

(3) Arundhati Roy (4) Amartya Sen

As per the Union Budget 2013, the Indian Government has proposed to éct up fund
of ¥ 1000 Cr for the safety and empowerment of women.

(1) Nirbhaya (2) Shourya

(3) Aanchal (4) Ekta

Which one of the following is not a company from South Korea ?
(1) Aiwa (2) Hyundai
(3) Samsung (4) LG

15



65.

67.

68.

69.

70.

Which of the following is a business venture from the house of Tatas ?
(1) Tanishg (2) Croma
(3) Westside (4) All of these

Who is the Comptroller and Auditor General of India ?
(1) Vinod Rai

(2) Shashi Kant Sharma

(3) VN Kaul

(4) None of these

‘Kerberos® and ‘Styx’ are the new names of the two smaller known moons orbiting
as given by the International Astronomical Union in 2013.

(1) Venus (2) Mars
(3) Saturn (4) Pluto

Which social networking site has the popular photo-sharing application ‘Instagram’ 7
(1) Twitter (2) Flickr

(3) Facebook (4) LinkedIn

Name the 266" elected Pope who took the new name ‘Francis I,

(1) Ivan Dias

(2) Jorge M Bergoglio

(3) Oswald Gracias

(4) George Alencherry

The well known double Olympic Champion Yelena Isinbayeva of Russia is connected
with which event ?

(1) Long jump (2) High jump
(3) Pole vault (4) Swimming
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Directions (Questions 71-75): Read the given information carefully to answer these questions.

71

i 8

73.

74.

he

There are six teachers A, B, C, D, E and F in a school. Each of the teachers teaches two
subjects, one compulsory subject and the other an optional subject. D’s optional subject is
History while three others have it as a compulsory subject. E and F have Physics as one of
their subjects. F's compulsory subject is Mathematics while it is an optional subject of
both C and E. History and English are A’s subjects but in terms of compulsory and
optional subjects, they are just reverse of those of D’s. Chemistry is an optional subject of
only one of them. The only female teacher in the school has English as her compulsory
subject.

What is C's compulsory subject ?

(1) History (2) Physics

(3) Chemistry (4) English

Who is the female teacher in the group ?

(1) A (2) E

(3) D s

Which of the following has same compulsory and optional subjects as those of F's 7
(1) D 2 E

(3) B (4) None of these

Which of the following groups has History as the compulsory subject ?
(1) A,CD (2) A,B,.C
(3) B,C,D (4) A, D

Disregarding which is the compulsory and which is the optional subject, who has the same
two subject combination as F 7

(L) E (2) A

(3) B (4 D

Directions (Questions 76-78): Complete the series by replacing ' ?'

76.

f &

78.

10000, 11000, 9900, 10890, 9801, * ?°

(1) 10241 (2) 10423
(3) 10781 (4) 10929
0, 6, 24, 60, 120, 210, * 7

(1) 240 (2) 290
(3) 336 (4) 504
2/3, 47, 77, 11121, 16/31

(1) 5/9 (2) 6/11
(3) 713 4 917
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Directions (Questions 79-83): Fach of these questions has a statement followed by two
arguments I and Il. Consider the statement and the following arguments. Decide which of
the arguments is strong from the statement, Mark the answer as

(1) il argument I is strong.

(2) if argument II is strong.

(3) if either argument I or II is strong,

(4) if neither argument | nor II is strong,

79.

80.

82,

83.

85.

Statement
Argument |

Argument 11

Statement
Argument |
Argument 11

Statement
Argument |
Argument II :

Statement
Argument |
Argument 11

Statement

Argument |
Argument [I :

: Should only one company be allowed to run the transport system in any

one big city ?

: Yes. This will put an end to unhealthy competition among different

companies.

: No. The commuter should be given a wider choice of transport system.

: Should there be more than one High Court in each State in India 7
: No, This will be a sheer wastage of taxpayers’ money. i
: Yes, This will help reduce the backlog of cases pending for a very long

time.

: Should there be a concentration of foreign investments only in few States ?
: No. It 1s against the policy of overall development of the country.

Yes. A large number of States lack infrastructure to attract foreign
investment.

: Should students take part in politics ?
: Yes. It inculcates i them qualities of leadership.
: No. They should study and build up their career.

: Should all the infrastructural development projects in India be handed uver-

to the private sector ?

: No. The private sector entities are not equipped 16 handle such projects.

Yes. Such projects are handled by private sector in the developed
countries.

Sachin said to Vinod. “That boy playing football is the younger of the two brothers of the
daughter of my father’s wife.” How is the boy playing fooiball related to Sachin ?

(1) Son
(3) Cousin

(2) Nephew
(4) Brother

A nver flows West to East and on the way turns left and goes in a semi-circle round a
hillock and then turns left at right angles. In which direction is the river finally flowing ?

(1) West
(3) East

__{2] South-East
(4) South
21



86.

87.

88.

90.

91.

92.

Four bells first begin to toll together and then at intervals of 6. 7, 8 and 9 seconds
respectively. At what interval (in sec.) will they toll together ?
(1) 504 (2) 14
(3) 42 4y 72

5 ; 3

res part of what amount will be equal to 3 / part of ¥ 100 7
(1) T 900 (2) T750
(3) T 600 (4) T450

2 . ; 1

The ratio of the salary of a worker in June to that in July was 221 : 21 . By what percent

was the salary of July more than the salary of June ?

(1) 10% (2) m%%
(3) 11%% (4) 9%

The average temperature on Tuesday, Wednesday and Thursday was 37°C. The average
temperature on Wednesday, Thursday and Friday was 38°C, If the temperature on Friday
was 39°C, find the temperature on Tuesday.

(1} 36°C () - 3TC

(3) 38°C (4) 39°C

A bag contains an equal number of one rupee, S0 paise and 25 paise coins respectively. If
the total value is ¥ 35, how many coins of each type are there ?

(1) 18 (2) 20

(3) 24 (4) 16

How many kg of salt at 42 paise per kg must a man mix with 25 kg of salt at 24 paise ;ﬁer
kg so that he may on selling the mixture at 40 paise per kg gain 25% on the outlay ?

(1) 25kg (2) 18kg

(3) 30kg (4) 20kg

Ten men begin to work together on a job, but after some days, 4 of them leave, As a
result, the job which could have been completed in 40 days is completed in 50 days. How
many days after the commencement of the work did the 4 men leave ?

(1) 30 days (2) 20 days

(3) 25days (4) 15 days
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94,

0s.

96.

97.

98.

99.

100.

Twao friends take a piece of work for ¥ 960. One could do it alone in 12 days and the other
in 16 days. With the assistance of an expert they finish it in 4 days. How much
remuneration should the expert get ? :

(1) 400 (2) T460

(3) T500 (4) %540

A tap can fill a cistern in 20 minutes and another can fill it in 30 minutes. [f both taps are
opened simultaneously, find the time taken for the cistern to fill.

(1} 15 min. (2) 18 min.

(3) 12 min. (4) 22 min.

A trader offers his customers 10% discount and still makes a profit of 26%. What is the
actual cost of an article marked % 280 to him ?

(1) 210 (2) T180

(3) T220 (4) T200

A man borrowed ¥ 2500 from two money lenders. For one loan, he paid 5% interest p.a.

. and for the other, he paid 7% interest p.a. The total interest paid for two years was ¥ 265,

How much did he borrow at each rate ?
(1) T 1875, T 625 (2y T 1850, T 650
(3) TI1925.7575 (4) T1750,F 750

Sumit borrowed a certain sum at the rate of 15% p.a. If he paid at the end of two years
¥ 1290 as interest compounded annually, find the sum he borrowed.

(1) ¥ 3600 (2) T4200

(3) 4000 (4) T 4500

Walking% of his usual speed, a boy reaches his school 6 minute late. Find the usual time

he takes to reach school.
(1) 12 min. (2) 15 min.
(3) 10 min. (4) 14 min.

A train 110 metres long travels at 60 km/hr. How long does it take to cross another train
170 metres long, running at 54 km/hr in the same direction ?

(1) 168 sec. (2) 135 sec.

(3) 210 sec. (4) 188 sec.

Find the sum of all two digit numbers that give a remainder of 5 when these numbers are
divided by 8.
(1) 461 (2) 583
(3) 643 (4) 733
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101.

102,

103.

104,

105.

106.

107.

108.

Who is the author of “The Law of The Library’ or ‘Granthalaya Veda' ?
(1) B S Kesavan

(2) Iyyanki Venkata Ramanayya

(3) S Parthasarathy

(4) Chilakamarti Lakshmi Narasimham

Nalanda Database of Indian Libraries was created by
(1) NISCAIR (2) DRTC
(3) ILA (4) National Library, Kolkata

K P Sinha Committee’s recommendations pertain to
(1) Special Libraries (2) Academic Libraries

(3) Public Libraries (4) Government Libraries

The Association for Information Management is the new name of

(1) ALA @) LA
(3) ASLIB ’ (4) IASLIC
The UDC 1s an example of

(1) Enumerative Scheme

(2) Faceted Scheme

(3) Almost Faceted Scheme

(4) Freely Faceted Scheme of Classification

The Colon Classification Book Number formula comprises elements.
(1) four (2} six

(3) eight (4) ten

How many Tables does the latest edition of DDC contain ?

(1) Four (2) Five

(3) Six (4) Seven

The Space Isolates of Colon Classification comprises blocks.
(1) two (2) three

(3) four (4) five
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109. The number of Canons for Book Classiﬁcaﬁéﬁ as given in Colon Classification (6" Rev.

edn.) 1s
(1) three (2) five
(3) seven (4) mnine

110. The book ‘Prolegomena to Classification” was brought out by S R Ranganathan in the

year
(1) 1928 2) 1937
(3) 1950 (4) 1960

111. The Call Number of a document comprises
(1) Accession No.
(2) Class No.
» (3)  Class No., Book No. and Sequence No.
(4) None of these

112. Anglo-American (AA) Code was published in the year
(1) 1876 (2) 1908
(3) 1949 (4) 1961

113. IATLIS is a body of
(1) Librarians.
-(2) Teachers of Library Science.
(3) Authors and Publishers.
(4) Both (1) and (2).

114. Edited works in AACR are entered under
(1) Editor. (2) Publication.
7 (3) Title of the document. (4) All these

115. Library of Congress CIP data is found on the
(1) title page of the document. «(2) back of the title page.
(3) last cover of the book. (4) dust cover of book.
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116. The number of sections in the Main Entry according to CCC is

(1) four (2) five
(3) six (4) seven
117. Medical libraries prefer to use for subject headings.
(1)  sears list of subject headings . (2) " MeSH
(3y LCSH (4) chain procedure

118. In India, ISSN is allotted by
(1) CSIR (2) NISCAIR
(3) 18I (4) DRTC

119. Broad System of Ordering (BSO) is a/an
(1) indexing system @) classification scheme
(3) catalogue code (4) management tool

120. DrS R Ranganathan has given details of the various jobs performed in a library in his
(1) Five Laws of Library Sciences.
(2) Colon Classification.
(3) Classified Catalogue Code.
(4) Library Administration.

121. The name of the Library Management Software developed by INFLIBNET is
(1) CDS/SIS. (2) NETTLIB.
. Q) SOUL. (4) PMB.
122. AGRINDEX is the publication of
(1) UNO (2) ILO
(3) ICAR {4) FAO

123. SOUL Software has ____ modules.
(1) four (2) five
(3) six (4) seven
31



124. INDEST consortium is for
(1) Social Science. (2) Humanities.

(3) Science & Technology. (4) Arts and Culture.

125. INFLIBNET is an autonomous inter-university centre of
(1) Deptt. of Science and Tech., Govt. of India
(2) Department of Culture, Govt. of India.
(3) National Library, Kolkata.

(4)  University Grants Commission.

126. Wall Picture Principle is a principle of
(1) facet sequence. (2) helpful sequence.
_(3) Both(l)and (2). (4) None of these

127. Credit for being the first Library Network in India goes to
(1) DELNET. (2) CALIBNET.
(3) INFLIBNET. (4) None of these

128. Which one of the following laws of library science advocates “Open Access” ?
(1) First Law (2) Second Law

(3) Third Law (4) Fourth Law

129. Which one of the following is not a secondary document ?

¢« (1) Library Herald (2) Annual Report
(3) Atlas (4) None of these
130. was the first National Librarian of Free India.
(1) R K Dasgupta {2) B S Kesavan
(3) DRKalia (4) Y M Malay

131. Which one of the following States enacted the Public Library Act, 2009 ?
(1) Uttar Pradesh (2) Rajasthan
(3) Arunachal Pradesh (4) Haryana
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132. How many levels do the Time Isolates have in the Colon Classification ?

(1) One (2) Two
(3) Three (4) Four
133. In Main Class __ of Colon Classification first level of [P] has been drawn from
Geographical Divisions.
(1) fine arts (2) Thistory
(3) law (4) all of these

134. First PhD in library science was awarded in India by
(1) Punjab University. 4(2) Delhi University.
(3) Madras University. (4) Calcutta University.

135. Which one among the following is the permanent record of a library ?

(1) Library Catalogue (2) Stock Register
(3)  Accession Register (4) Shelf List
136. The new Encyclopedia Britannica is in part(s).
(1) one (2) two
.(3) three (4) four

137. The frequency of British National Bibliography is
(1)  Weekly. (2) Monthly.
(3) Quarterly. (4) Annually.

138. E-granthalaya Library Software has been developed by
-(1) NIC (2) DELNET
(3) CALIBNET (4) NISCAIR

139, N-LIST has been developed to benefit in India.
(1) schools (2) colleges

(3) universities (4) industries
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140. Information on people and places is to be found in
(1) Encyclopedia. -(2) Gazetteer.
(3) Quotations. (4) Digest.

141. In which category of libraries, do “overdue charges” form an additional source of

income ?
(1) Academic (2) Speecial
(3) Public (4) All of these

142. The concept of idea plane, verbal plane and notational plane was developed by
11) S R Ranganathan. (2) M A Gopinath.
(3) A Neelameghan. (4) G Bhattacharyva.

143. Collection number is a part of
=(1) Call no. (2) Book no.
(3) Class no. (4) None of these

144. In India, during the British period. the Librarians Club was set up in at

(1) 1929, Lahore (2) 1919, Lucknow
(3) 1919, Calcutta (4) 1929, New Delhi
145. 'MALA Infozine’ is a of Madras Library Association.
(1) booklet (2) conference proceedings
(3) newsletter (4) thesis

146, CILIP stands for
(1)  Chartered Institute of Library and Information Professionals.
(2) Chatrapati Institute of Library and Infnnnalion Professionals.
(3) Chartered Institute of Librarians and Information Professors.
(4) None of these

147. Chattopadhyay Committee was appointed by
(1) Raja Ram Mohan Roy Library Foundation.
(2) Department of Culture, Govt. of India.
(3) Indian Library Association.
(4) National Library, Calcutta.
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148. The National Mission on Libraries is reconstituted every
(1) 3 years. (2) 4 years.
(3) 5 years. (4) None of these

149, Library legislation helps in
(1) improving library services.
(2) librarians getting better pay.
(3) saving money of users in purchasing books.
(4) None of these

150. Model Library Bill helps in
(1) knowing public libraries better.
(2) modifying existing Library Acts.
(3) drafting Library Acts.
(4) None of these

151. Dr S R Ranganathan presented the first Model Library Bill at the
(1)  All Asia Educational Conference, Banaras,
(2)  All India Library Conference, Calcutta.
(3) Madras Library Association Conference, Madras.
(4) Maharashtra Public Library Meeting, Mumbai.

152. Library legislation was enacted for the first time in independent [ndia by the
(1) Madras State. (2) Hyderabad State,
(3) Kolhapur State. (4) Calcutta State.

153. Library cess is not provided for in
(1) Madras Public Libraries Act,
(2)  Andhra Pradesh Public Libraries Act.
(3) Maharashtra Public Library Act.
(4) None of these

154. Which one of the following States made library membership compulsory for students on
reaching standard VIII ?

(1)  Arunachal Pradesh (2) Uttar Pradesh
(3) Chhattisgarh (4) None of these
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155. In which of the following States Library Department is a “cell” of the Education
Department ?

(1)  Arunachal Pradesh (2)  Chhattisgarh
(3) Rajasthan (4) Himachal Pradesh

156. A major activity of RRRLF is to provide for library services.
(1) assistance programme (2)  building facility

(3) human resources (4) none of these

157. Ergonomucs is also known as
(1) electrical engineering,
(2) cybemetics.
. (3)  human factors engineering.

(4) study of economics.

158. Periodical records, if maintained manually, are maintained in
{1) kardex or a linedex. (2) racks.
(3) almirahs. (4) catalogues.

159. UNESCO defines a book as *a bound non-periodical publication” having
(1) 49 or more pages. (2) 100 or more pages.
(3) 25 or more pages. (4) 150 or more pages.

160. E-zine is a term used for
(1) english magazines.
(2) engineering magazines.
(3) electronic magazines.

(4)  small magazines and newsletters distributed by any electronic method.

161. Newark Charging System was introduced in
(1) 1900, (2) 1901.

(3) 1902 (4) 1903,
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162.

163.

164.

165.

166.

167.

Staff development ensures __ of employees of a library.
»(1) personal and professional development

(2) future

(3) personality development

(4) regular job

The chief qualities and skills required by public library staff is/are
(1) communication abilities for interacting with various members of the society.
(2) ability to understand the needs of users.

(3) both(1)and (2).

(4) None of these

Which among the following libraries serves as a “depository library” of the United
Nations ?

(1) Delhi Public Library.

(2) Connemara Public Library.

(3) Kerala State Central Library.
(4) Karnataka State Central Library.

National Mission on Libraries was established in the year

(1) 2005, (2), 2012.

(3) 2013. (4) 2009,

How many States in India have library legislation as on July, 2013 ?
(1) 12 (2) 14

(3) 19 4 9

In public library, guidelines by Bureau of Indian Standards have which of the following
details ?

(1) Services to be provided to children and backward classes.
(2) Details of space required for a library.

(3) Model Public Libraries Act. &

(4) Public Libraries Manifesto.



168.

Library Standards are to be followed for the purpose of
(1) purchase of books.

(2) finalizing the list of periodicals.

(3) exchange of bibliographic records.

&

(4) registration of new members.

169. The Raja Ram Mohan Roy Library Foundation has been set up to

(1) encourage resource sharing.

(2) support application of technology in libraries.

 (3) provide financial and other assistance for public library development.

(4) develop standards.

170. A Public Library is required to meet the information needs of the

171.

172.

173.

(1) local community. (2) business corporations.

(3) university teachers. (4) government organizations.

Concept of Reference Service was first initiated by
(1) S Parthasarathy (2) Melvil Dewey
(3) Samuel S Green (4) Justin Winsor

The term ‘reference work’ appeared for the first time in a library journal n
(1) 1876. (2) 1883,

(3) 1891, (4) 1893.

Library legislation is related with the development of

. (1) Public Libraries. (2) Special Libraries.

(3) Academic Libraries (4) All of these

174. Who is the executive head and ex-officio member secretary of RRRLF 7

(1) Joint Secretary, (2) Chairman.
(3) Director. (4) Principal.
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175. Which one of the following is a heritage library ?
(1) Marwari Library.
(2) Dyal Singh Public Library.
(3) Purushottam Das Tandon Library.
(4) Lalt Kala Library.

176. The original name of the Asiatic Society Library located at Mumbai is
(1) Literary Society.
(2) Directorate of Public Libraries.
(3) State Central Library.
(4) Central Reference Library.

177. Mumbai Marathi Grantha Sangrahalaya was established in
(1) 1893, (2) 189s.
(3) 1898 (4) 1891.

178. Currently the Central Library, Baroda 1s a
(1) State Central Library. (2) District Library,

(3) Public Library. (4) Special Library.

179. Khuda Bakhsh Oriental Public Library is located at

(1) Rampur (2) Lucknow
(3) Pana (4) Kanpur
180. Most of the Public Libraries use Scheme for classification uf_ books.

(1) Colon Classification
(2) Dewey Decimal Classification
(3) Universal Decimal Classification
(4) Universal

181. In most of the Public Libraries, photocopy service is
(1) apaid service. (2) a free service.
(3) asubsidized service. ; (4) not a service.
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182,

183.

184,

185.

186.
(1) Vavilala Gopalakrishnayya

187.

Dictionaries and Encyclopedias are kept in section of the library.
(1) rare collection (2) textbook collection
. (3) reference collection (4) none of these

service falls within the extension service.

(1) Reference

A{2) Mobile library

(3) Issue and return of books

(4) None of these

single handedly without the support of government, built and ran a public library

in Jaipur, popularly called Sanmati Pustakalaya.
(1) Master Motilalji (2) NC Divanji
(3) Motibhai N Amin (4) DR Kalia

Who said “each village should have libraries like we have tanks and wells” ?
(1) R K Dasgupta

(2) Chilakamarti Lakshmi Narasimham

(3) Vavilala Gopalakrishnayya

(4) KM Asadullah

Who organized library pilgrimages in Andhra ?
(2) Iyyanki Venkata Ramanayya

(3) Paturi Nagabhushnam
(4) A Neelameghan

Delhi Society for Promotion of Literary and Cultural Activities was formed in the year
(1) 1862 (2) 1865
(3) 1870 (4) 1875
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188, The RRRLF has taken an initiative to develop in collaboration with Nehru Yuvak
Kendra Sangathan.

(1) District Youth Resource Centers (DYRC)
(2) Libraries and Information Centers
(3) All Gram Panchayats

(4) Rural Information Centers

189. International Serials Data System (ISDS) was established in 1971 by
(1) FID. (2) IFLA.
(3) UNESCO. (4) UNISIST.

190. What is the use of the Bookmark in Microsoft Word 7
(1) To easily correct the spelling errors.
(2) To quickly jump to a specific location in the document.
(3) To quickly jump to the end of the document.

(4) To create a link within the document,

191. Which is the short cut key for manual line break in an MS Word document ?
(1) Citrl + Enter (2) Alt+ Enter
(3) Shift + Enter (4) Space + Enter

192. Which of the following commands lets you set the vertical alignment of a document in
MS Word ? : '

(1) Page setup command from File menu.
(2) Page setup command from Format menu.
(3) Paragraph command from Format menu.

(4) Font command from Format menu.

193. Minimum zoom out percentage supported by MS Word is
(1) 10% (2) 15%
(3) 25% 4) 4%
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194.

195.

196.

197.

198.

199.

200.

The KWIC indexing method is based on which one of the following ?

(1) Title (2) Citation

(3) Abstracts (4) Full text

‘What does the two letters CO represent in the acronym POSDCORB ?
(1) Cooperation .(2) Coordination

(3) Corporation (4) Communication

The accession register in the libraries is prepared to

(1) regster books.
(2) register books and periodicals.

/(3) accessing the books in an order in which they are received in the library.

(4) register every item which is brought in the library,

‘Granthalaya Jyoti” is a collection of the essays and speeches on library movement of
from 1910 to 1966.

(1) lyyanki Venkata Ramanayya (2) M A Gopinath
(3) A Neelameghan (4) Patuni Nagabhushnam

The *Saraswathi Samrajya Bhavanam’ is located at
(1) Hyderabad (2) Chennai
(3) Trivandrum (4) Viayawada

Which one of the following organizations joined the Library Association to form CILIP in
20122 -

(1) Institute of Librarianship.
(2) Institute of Documentation.
(3) Institute of Information Scientists.

(4) Institute of Bibliography.

The Indian Library Association (ILA) was founded in the year
(1) 1943 (2) 1933
(3) 1921 (4) 1928
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